Preparing to Upgrade Tasks Summary—IMPAX 4.5, 5.2, 5.3, or
WEB1000 to IMPAX 6.5.1

Prerequisite software installations

Before proceeding with the migration to
IMPAX 6.5.1, migrate or install the following
software.

e If currently running PACS Broker 1.5.3,
1.5.4 or 1.5.5, you must migrate to
Connectivity Manager 2.2.1 or 2.3 under the
following circumstances:

e Multi-site installations (for report
queries from multiple sources)

e VPN sites

e EPR integrations with HL7 backend
messaging

e IMPAX RIS integrations
e IMPAX RIS CD burning

e Cardiology integrations

¢ And if you require the following new IMPAX
and Connectivity Manager functionality, you
must migrate to Connectivity Manager 2.2.1
or 2.3:

e Report viewing in the IMPAX Text area
e IHE workflows

e MPPS communication from modalities
¢ Audit messaging

e Language support for Latin 4 character
sets

To continue to use PACS Broker 1.5.3, 1.5.4 or
1.5.5—and if the preceding circumstances do not
apply—install the PACS Broker DICOM Interface
Su2.

You can also install or upgrade the versions of the
following products before upgrading to

IMPAX 6.5.1. These components are optional and
may not be used by all sites.

e If intending to use the IMPAX Reporting
integration with the IMPAX Client, IMPAX
RIS must be upgraded to version 5.4.1. For
upgrade instructions, refer to the IMPAX RIS
InstallShield Technical Manual.

e TalkStation must be upgraded to TalkStation
3.2 or 4.0. For instructions on upgrading
TalkStation, refer to the TalkStation 4.0
Client Upgrade and Migration Guide and the
appropriate version of the TalkStation 4.0
Server Upgrade Guide.

e Audit Manager. For installation instructions,
refer to the Audit Manager 1.2 Installation,
Upgrade, and Configuration Guide.

Installing external software on
new servers

If, through your analysis, you determine that you
will be adding new AS300 or AS3000 server
stations to your cluster, you can install the
required external (that is, non-Agfa) software on
these stations during the preparing to upgrade
period. This is also the case when migrating a
WEB1000 site.

For details on how to install external software on
a new single-host, Database Server, Archive
Server, or Network Gateway, refer to the IMPAX
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6.5.1 AS300 Installation and Configuration Guide
or the IMPAX 6.5.1 AS3000 Installation and
Configuration Guide.

In the IMPAX 6.5.1 AS300 Installation and
Configuration Guide, Oracle on Windows is the
recommended database for new installations.
However, when installing a new IMPAX AS300
Database Server as part of the upgrade, if SQL
Server was previously used, then you must install
SQL Server as part of the IMPAX 6.5.1 upgrade.

Installing SQL Server 2008

1. Log into Windows as an administrator-level
user.

2. Launch the installer and select Installation
from the left-hand menu of the SQL Server
Installation Center.

3. To perform a new installation of SQL Server
2008, select the first option, New SQL
Server stand-alone installation or add
features to an existing installation.

4. If asked whether or not you want to run this
application, click Run.

5. To install a permanent version of SQL Server
2008, confirm that the product key exists
and click Next.

6. To accept the license terms and conditions,
on the License Terms screen, read the
license agreement and select the relevant
checkbox.

7. To allow the Installation Wizard to install or
update SQL Server 2008, on the Setup
Support files screen, click Install.

8. Wait until all components are installed and
configured, then click Next on the Setup
Support Rules screen. Ensure that no
significant errors exist.
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9. On the Feature Selection Page screen, select
the required components (as in the image
that follows). Click Next.

10. On the Instance Configuration screen, select
Default instance. Click Next.

11. The Disk Space Requirements screen verifies
that sufficient disk space exists for the
features you have selected. Click Next.

12. On the Server Configuration screen, on the
Service Accounts tab, select NT
AUTHORITY\SYSTEM as the Account
Name for the login accounts for SQL Server
services (as in the image that follows). Click
Next.

13. On the Database Engine Configuration
screen, on the Account Provisioning tab,
select Mixed Mode (SQL Server
authentication and Windows
authentication) and type the sa (system
administrator) password.

14. To add the administrative user, click Add.

15.
16. On the Ready to Install screen, click Install.

17. On the Installation Progress screen, click
Next.

18. On the Complete screen, click Close.
19. Close the SQL Server Installation Center.

20. Restart the computer and log into Windows
as an administrator-level user.

Stopping SQL Server 2008
services
1. Open the Windows Administrative Tools.
2. Select Services.

3. Select each of the following services in turn
and click Stop Service, if needed:

a. SQL Server Full Text Search

b. SQL Server Full Text Filter Daemon
Launcher

c. SQL Server Browser

d. SQL Server Integration Services
10.0

4. Close the Services window.
Upgrading SQL Server 2008 to
SQL Server 2008 SP1

1. Launch the SP1 installer.

2. If you see a security warning, click Run.

. On the Welcome screen, click Next.

3
4. On the License Terms screen, select I
accept the agreement. Click Next.

5. On the Feature Selection screen, accept the
default selections. Click Next.

6. On the Check Files in Use screen, wait while
the processes are identified. Then, click
Next, even if some locked files are found.

7. On the Ready to Update screen, click
Update.

8. On the Update Progress screen, wait until
the components are upgraded or installed,
then click Next.

9. If the Computer Reboot Required prompt
appears, click OK.

10. On the Installation Complete screen, click
Close.

11. Restart the computer.

Obtaining Server licenses for
Windows stations

1. For each Windows server, open a command
prompt and type ipconfig /all.

2. Copy one of the returned MAC addresses to
a secure place.

3. To obtain a license key for the server, send
the MAC address information to
licensekey@agfa.com, along with the type
of component being installed on that server.
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Obtaining Server licenses for
Solaris stations
1. On a Solaris station, confirm that the
Ethernet is connected.

2. Login as the root user and open a terminal
window.

3. Type
arp “uname -n’
or
arp $(uname -n)

4. To obtain a license key for the server, copy
and send the returned information to
licensekey@agfa.com, along with a
description of the type of component being
installed on that server.

Installing hardware and software
on a new Application Server

To prepare a server for an IMPAX Business
Services installation, you must install the
appropriate hardware and external software on
it. For upgrades, you have the option of staying
with Windows Server 2003 or upgrading to
Windows Server 2008.

Setting up an AS300 single-host
server

During the preparing to upgrade period, set up
the future Curator station as a single-host AS300
Oracle station, for use within the training server
cluster. Details for these installation procedures
are available in the IMPAX 6.5.1 AS300
Installation and Configuration Guide.

Installing the IMPAX
documentation

1. Insert the IMPAX Documentation DVD.

2. From the DVD root, double-click
IMPAXDocumentationSetup.exe.

3. On the Welcome screen, click Next.
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On the Setup Type screen, select the
appropriate option and click Next.

If you selected Select Documentation to
Install, on the Choose Features screen, you
can select particular Knowledge Bases or
languages to install.

On the Ready to Install the Program screen,
click Install.

On the InstallShield Wizard Completed
screen, click Finish.

Configuring IIS error messages
on Windows Server 2003

1.

Open the Windows Administrative Tools and
select Internet Information Services
(I1IS) Manager.

Expand computer_name > Web Sites
> Default Web Site.

Right-click the Documents file and select
Properties.

4. Switch to the Custom Errors tab.

5. Inthe list of Error messages for HTTP errors,

select 404.

6. Click Edit.
7. Under Message Type, select URL.
8. In the URL field, type

9.
10.

/AgfaHC.LanguageRedirect/
LanguageRedirect.aspx.

To close the two dialogs, click OK in each.

To close the Internet Information Services
(IIS) Manager window, select File > Exit.

Installing the IMPAX Business
Services

1.
2.

Insert the IMPAX Business Services CD.

Navigate to the appserver folder, which
contains the Business Services software.

Run AGFA IMPAX Business Services
Setup.exe.

Select the required software packages to
install.

5. Click Install.
6. On the Welcome screen, click Next.

7. At the license agreement, select the I

accept the terms in the license
agreement checkbox. Click Next.

8. On the Web Services Installation Folder
screen, click Change.

9. Select E:\wwwroot as the location for the
Web Services. Click OK.

10. Click Next.

11. On the Setup Type screen, click Custom.
Click Next.

12. If you have an IMPAX RIS to connect to,
under RIS Web Services, select This
feature will be installed on local hard
drive. Click Next.

13. Click Install.

14. To continue with the configuration after the
installation is complete and verified, select
the Launch Configuration tool checkbox.

15. Click Finish.

Verifying the Business Services
installation
1. Open a web browser and connect to

2.

http:/ /localhost.

Verify that the "IMPAX Documentation” page
is displayed.

or

If the IMPAX Documentation has not been

installed on the server, that the “"Welcome
to IMPAX 6.5.1" page is displayed.

Order of Application Server
configuration

Configure the Application Server software.
Configuration details are available in the IMPAX

© Copyright 2011 Agfa HealthCare N.V., Septestraat 27, B-2640, Mortsel, Belgium
14 June 2011

6.5.1 Application Server Installation, Upgrade,
and Configuration Guide.

Restoring the unmodified uname
script

1.

Log into the Database Server as the root
user.

2. Change to the /sbin directory.

3. Back up the modified uname script by typing

cp uname uname.agfa

4. Locate the unmodified backup script.

5. Restore the unmodified backup script by

typing
cp backup uname

Installing the Migration Toolbox
on a Windows station

1.
2.

Insert the IMPAX Migration CD.

Navigate to the win32 directory and
double-click
impax_65_migration-winpkg-6.5.1.00c.exe

In the InstallShield Self-extracting EXE
dialog, click Yes.

4, On the Welcome screen, click Next.

On the Select Features screen, select the
checkboxes of the features that you want
to install, and clear the rest.

6. Click Next.

7. To continue, click Install.

8. If you selected the Worklist and Report

9.

Migration Tools on the Select Features
screen, when prompted, press any key to
continue.

On the Setup Complete screen, click Finish.

Accessing the IMPAX migration
software repository

1.
2.

Login as user root.

At a terminal window, type
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3.

lofiadm -a
/ISO_directory/IMPAXMigration.iso.

Type
mount -F hsfs /dev/lofi/1 /mntl.

Change to the /mnt1 directory (or whatever
mount point you are using).

Installing the Migration Toolbox
on a Solaris station

1.

Log in as the root user and open a terminal
window.

Insert the Migration Tools CD.

3. Navigate to the SunOS5 directory.

To install the migration tools, type
pkgadd -d IMPAXmigration.pkg

When asked which packages to process,
type the package name or all to process
them all.

When asked if you want to continue with the
installation, type y.

Because environment variables are updated
during the Migration Toolbox installation, if
you have any terminal windows open with
the mvf user login, you must log out and
log back in again.

Setting up a connection to a
previous-version AS300 database

1.

ik wn

Open the Windows Administrative Tools.
Select Data Sources (ODBC).

Switch to the System DSN tab.

Click Add.

In the Create New Data Source dialog, select
SQL Server from the list. Click Finish.

In the Name field, type the appropriate
value:

For IMPAX 4.5 upgrades, use mvf_45.
For IMPAX 5.2 upgrades, use mvf_52.

10.

11.
12.

13.

For IMPAX 5.3 upgrades, use mvf_53.

In the Description field, type mvf
(lowercase).

In the Server field, type or select the name
of the 4.5, 5.2, or 5.3 AS300 server. Click
Next.

Set the authentication according to the
authentication used at the site (Windows
NT or SQL Server).

If using SQL Server, you may also have to
select the Connect to SQL Server
checkbox and supply a Login ID and
Password.

If necessary, change the network library by
clicking Client Configuration. Under
Network libraries, select the protocol used
to communicate with the SQL server at your
site: either TCP/IP (the default) or Named
Pipes. Click OK.

Click Next.

Change the default database to mvf
(lowercase). Click Next.

Click Finish. Click OK.

Connecting to a 4.5, 5.2, or 5.3
AS3000 database

1.

Select Start > All Programs > Oracle -
Oracle_instance_name > Configuration
and Migration Tools > Net Configuration
Assistant

In the Oracle Net Configuration Assistant
Welcome dialog, select Local Net Service
Name configuration and click Next.

If the Naming Methods Configuration dialog
appears, select Local Naming and click
Next.

In the Net Service Name Configuration
dialog, select Add and click Next.

In the Service Name field, type MVF and
click Next.
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10.
11.

12.

13.

14.

15.

16.

17.

From the list of protocols, select TCP and
click Next.

. In the TCP/IP dialog, type the host name of

the 4.5, 5.2, or 5.3 AS3000 server.

. Accept the default port number (1521) and

click Next.
Select Yes, perform a test and click Next.
Click Change Login.

In the Username and Password fields, type
mvf. Click OK.

Click Next.

In the Net Service Name field, ensure that
mvf_45, mvf_52, or mvf_53 appears and
click Next.

At the prompt to configure another net
service name, select No and click Next.

In the Net Service Name Configuration
Complete dialog, click Next.

In the Naming Methods Configuration
Complete dialog, click Next.

To close the Net Configuration Assistant
dialog, click Finish.

Configuring the ODBC data source
name

1.

u b W N

Open the Windows Administrative Tools.
Select Data Sources (ODBC).

Switch to the System DSN tab.

Click Add.

In the Create New Data Source dialog, select
Oracle in Oracle_instance_name and
click Finish.

. In the Data Source Name field, type the

appropriate value:

For upgrades from IMPAX 4.5, type mvf_45.
For upgrades from IMPAX 5.2, type mvf_52.
For upgrades from IMPAX 5.3, type mvf_53.

. Type a description, if needed.
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8. In the TNS Service Name field, type
mvf_45, mvf_52, or mvf_53.

9. In the User Name field, type mvf
(lowercase).

10. To save the changes and close the dialog,
click OK.

11. To save the new source and exit the ODBC
Data Source Administrator dialog, click OK.

Setting up a connection to the
WEB1000 database

Open the Windows Administrative Tools.
Select Data Sources (ODBC).

Switch to the System DSN tab.

Click Add.

In the Create New Data Source dialog, select
SQL Server from the list. Click Finish.

In the Name field, type mvf_web.

i AW

o

7. In the Description field, type mvf
(lowercase).

8. In the Server field, type or select the name
of the WEB1000 Server. Click Next.

9. Set the authentication according to the
authentication used at the site (Windows
NT or SQL Server).

If using SQL Server, you may also have to
select the Connect to SQL Server
checkbox and supply a Login ID and
Password.

10. If necessary, change the network library by
clicking Client Configuration. Under
Network libraries, select the protocol used
to communicate with the SQL server at your
site: either TCP/IP (the default) or Named
Pipes. Click OK.

11. Click Next.

12. Change the default database to mvf
(lowercase). Click Next.

13. Click Finish. Click OK.

Installing the IMPAX Installation
Server

You can set up an IMPAX Client Installation Server
by running the IMPAXInstallationServerSetup.exe
on a Windows-based server.

If you choose to install the IMPAX Installation
Server package on a dedicated server, use the
Web Server Certificate Wizard to create a
certificate request to submit to a trusted certificate
authority, and install the certificate. You must
install the SSL certificate on the dedicated server
before installing the IMPAX Installation Server
package.

Running the IMPAX Installation
Server package

1. From the IMPAX Client CD or a network
location, run
IMPAXInstallationServerSetup.exe.

2. On the Welcome to the InstallShield Wizard
for IMPAX Installation Server screen, click
Next.

3. To install the application into
C:\Inetpub\wwwroot\ClientInstaller, on the
Destination Folder screen, click Next.

or

To install the application to another location,
click Change. In the Change Current
Destination Folder dialog, browse for the
directory location to install into and click
OK. On the Destination Folder screen, click
Next.

4. On the Ready to Install the Program screen,
click Install.

5. On the Installation Wizard Completed
screen, click Finish.

6. On the second Installation Wizard Completed
screen, click Finish.
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Running the Microsoft .NET
Framework 3.5 SP1 installer
package
1. From the IMPAX Client CD or a network
location, run IMPAXInstallationServer_
DotNet35Updater.exe.

2. On the Welcome to the InstallShield Wizard
for Agfa IMPAX Installation Server - .NET
3.5 SP1 Updater screen, click Next.

3. To install the application into
C:\Inetpub\wwwroot\ClientInstaller, on the
Destination Folder screen, click Next.

or

To install the application to another location,
click Change. In the Change Current
Destination Folder dialog, browse for the
directory location to install into and click
OK. On the Destination Folder screen, click
Next.

4. On the Ready to Install the Program screen,
click Install.

5. On the Installation Wizard Completed
screen, click Finish.

Enabling automated installation
of the IMPAX Client software from
a command prompt

1. At a command prompt, type

ImpaxClientSetup.exe /S
/v"setting=value... /quiet"

Copying the 5.2 or 5.3
Cross-Cluster Dictation Interlock
components

1. On the 6.5.1 Application Server where the
zip file was extracted, from the
mvf-signal-relay directory, copy the
mvf_signal_relay.exe and
install_signal_relay.bat files.

2. On the IMPAX 5.2 or 5.3 computer to run
the components on, in the C:\mvf\bin

5/14



7.

directory, paste the two files copied in the
previous step.

Open a command prompt.
Change to the C:\mvf\bin directory.

Type install_signal_relay.bat
remote_host_name

Open the Windows Administrative Tools and
select Services.

Start the service.

Updating map_ini values for
Cross-Cluster Dictation Interlock

1.
2.

3.

Launch CLUI.

Type

update map_ini set
ini_value='remote_host_name' where
ini_section="signal-relay' and
ini_key='remote_host'

Type

update map_ini set
ini_value='remote_port_value' where
ini_section="signal-relay' and
ini_key='remote_port'

Optionally, change the default values of the
external_port, rad_user, or trainee_user
keys.

Copying the 6.5.1 Cross-Cluster
Dictation Interlock components

1.

Copy the study-status-signal-relay folder
from the Cross-Cluster Dictation Interlock
zip in the Tools subdirectory to an
appropriate folder on the 6.5.1 Application
Server, such as to C:\Program
Files\Agfa\Impax Business Services.

Open a command prompt.

3. Change to the directory containing the

copied files.

Change to the study-status-signal-relay
directory.

5.
6.

Type import-study-status-relay.bat.

In the Apply Study Status Relay ADAM
Schema dialog, click OK.

Configuring a firewall exception
for the Cross-Cluster Dictation
Interlock tool

1.

i wn

On the IMPAX 6.5.1 Application Server, open
Control Panel.

Select Windows Firewall.
Switch to the Exceptions tab.
Click Add Port.

In the Name field, type a name for the
exception; for example, Study Status
Relay or something similar.

In the Port field, type the number of the TCP
port to listen for signals from the remote
cluster.

7. Click OK.

8. To close the Windows Firewall dialog, click

OK.

Configure a firewall exception on the
Windows machine in the remote cluster as
well.

Configuring the Study Status
Relay role

1.

Launch an IMPAX Client connected to the
Application Server where the Study Status
Relay role was created.

2. Loginto the Client as an Administrator user.

3. From the Configure drawer menu u,

select Users and Roles.

In the navigation pane, right-click the Study
Status Relay role and select Add User.

In the details pane, under the User bar,
switch to the Information tab.

. Type a Name for the user, such as Remote

Dictation Automated User.
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7. In the Login field, type remote-dictation.

8. Type in a Password and note what this

10.

11.

password is.

In the navigation pane, select the Study
Status Relay role again.

In the details pane, expand the Licensing
bar.

In the navigation pane, right-click the
Study-Status Relay role and select Add
License > Add license_type

Configuring the Study Status
Relay service

1.

On the 6.5.1 Application Server, open a
command prompt.

Change to the C:\Program
Files\Agfa\Impax Business
Services\study-status-signal-relay
directory.

. Type

Study.Status.Relay.EncryptionTool.exe
password_for_remote-dictation_user

Copy the long string that is returned from
this command.

Open the Study.Status.Relay.exe.config file
in a text editor.

Under StudyStatusRelayConfiguration,
between the <User Passwor d> and

</ User Passwor d> tags, paste the long
string.

. Update the values of LoginServiceUrl,

StudyInfoServiceUrl, and
MessagingServiceUrl with the local
Application Server’s fully qualified domain
name.

Update the value of RemoteSignalHost
with the host name or IP address of the
computer in the previous-release version of
IMPAX that is running the study-status-relay
service.

Save and close the file.
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10. In the command prompt, type
install_study_status_relay_service.bat.

Running the Cross-Cluster
Dictation Interlock tool

1. On the 6.5.1 Application Server where the
Relay service is running, open a command
prompt.

2. Type the following command:
net start StudyStatusRelayService
3. Exit the command prompt.
Creating the pre-migration

schemaon an AS300 or WEB1000
server

1. Open a command prompt.
2. Change to the C:\mvf-mig6\bin directory.
3. Type the following:
build-impax-mig-schema.bat sa sa mvf
4. At the Do you want to proceed? prompt,
typey.
Creating the pre-migration
schema on an AS3000 server

1. Log into the AS3000 Database Server as the
oracle user.

2. Change to the /usr/mvf-mig6/bin
directory.

3. Run the script called
./build-impax-mig-schema.

Creating the pre-migration
schema from the Application
Server

1. On the Application Server, open a command
prompt.

2. Change to the C:\mvf-mig6\bin directory.

3. If the Application Server is connected to a
SQL Server database, type

build-impax-mig-schema.bat
user_name password
mvf_version_number

If the Application Server is connected to an
Oracle database, type
build-impax-mig-schema.bat without any
additional parameters.

Installing the Oracle 10.2.0.1
Client

1.

10.

Unzip the 10201_client_win32.zip file.

2. Run the unzipped Oracle 10g Client installer.
3.
4
5

To open the Universal Installer, click Install.

. In the Welcome dialog, click Next.

. In the Installation type dialog, select

Administrator. Click Next.

Under Destination, in the Name field, accept
the default or type a new name.

Under Destination, in the Path field, select
or type a path identifying where you want
to install the Oracle Client.

In the Product Specific Pre-requisite Checks
dialog, click Next.

In the Summary dialog, click Install.

If you are not continuing with configuration
immediately, close the Configuration
Assistant by clicking Stop.

Setting up the connection to the
Oracle database

1.

If the Net Configuration Assistant is not
open, select Start > All Programs >
Oracle - Oracle_instance_name >
Configuration and Migration Tools > Net
Configuration Assistant.

In the Oracle Net Configuration Assistant
Welcome dialog, select Local Net Service
Name configuration and click Next.

If the Naming Methods Configuration dialog
appears, select Local Naming. Click Next.
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9.
10.
11.

12.
13.
14.

15.

16.

17.

18.

In the Net Service Name Configuration
dialog, select Add. Click Next.

In the Service Name field, type MVF and
click Next.

From the list of protocols, select TCP. Click
Next.

In the TCP/IP dialog, type the host name of
the Oracle server.

. Accept the default port number (1521). Click

Next.
Select Yes, perform a test. Click Next.
Click Change Login.

In the Username field, type mvf and type
the password for the mvf user.

Click OK.
Click Next.

In the Net Service Name field, ensure that
MVF_ts.world appears. Click Next.

At the prompt to configure another net
service name, select No. Click Next.

In the Net Service Name Configuration
Complete dialog, click Next.

In the Naming Methods Configuration
Complete dialog, click Next.

To close the Net Configuration Assistant
dialog, click Finish.

Migrating reports to the training
server

1.

On the Application Server component of the
training server cluster, run the
C:/mvf-mig6/MigrateTRServer/
MigrateTRServer.exe application.

2. Select the Migrate Report Data checkbox.

3. Under Source, supply the database

information for the production server, as
follows:

a. Click Modify. D
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4,

b. In the Data Link Properties dialog,
select Microsoft OLE DB Provider
for SQL Server. Click Next.

c. In the Data Source field, type
mvf_ts.world or the name of the tns
entry that was created in
tnsnames.ora.

d. Select Use a specific name and
password and type the database user
name—normally sa.

e. In the Select the database on the
server field, type mvf.

f. Click OK.

In the Migrate training/traveling server data
dialog, under Source, type the database
password.

Under Destination, supply the database
information for the training server database,
as follows:

a. Click Modify. D

b. In the Data Link Properties dialog,
select Oracle Provider for OLE DB.
Click Next.

c. In the Data Source field, type
mvf_ts.world or the name of the tns
entry that was created in
tnsnames.ora.

d. Select Use a specific name and
password and type the database user
name—normally dbadmin.

e. In the Select the database on the
server field, type mvf.

f. Click OK.

On the training server, the database
password will be encrypted. To retrieve it,
use the following command at C:\mvf\bin:

passkey -M QUERY -u sa

Then type the retrieved value into the
Destination Password field.

7.
8.

Click Migrate Data.

When the migration is complete, close the
DTSResults dialog.

Collecting information on IMPAX
clients, servers, stations, and

printers

1. On Solaris, log in as the mvf user.

2. At a command prompt, change to the
directory containing the migration_inventory
tool.

3. On Windows, type
migration_inventory.exe -s [-d
database_name -U
database_user_name -P
database_password] -D
database_server_host_name
On Solaris, type
migration_inventory -s -D
database_server_host_name

4. To create a report file with this information,

on Windows, type

mig_reporter.exe -d
mvf_version_number -t
system_inventory_tool

On Solaris, type

mig_reporter -d mvf_version_number
-t system_inventory_tool

Increasing the tablespace size on
Solaris

1.

2.

Log into the Database Server as the mvf
user.

Start the database by typing
dbstartmvf

Start the listener. Type
Isnrctl start

Change to the /usr/mvf-mig6/bin
directory.
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. To see whether 2-3 GB of space is available

for the MVFL tablespaces, type
/usr/mvf/bin/monitor_update
/usr/mvf/bin/monitor_stats

If additional space is needed, to run the
monitor_add script, type

/usr/mvf/bin/monitor_add

7. To continue, type C.

8. Type the tablespace name, MVFL.

9. Type the path name for the data file.

10.

11.

Type the size of the file in megabytes,
2000.

Repeat these steps for the MVFLINDX, MVF,
MVFINDX, and UNDO tablespaces,
substituting the appropriate tablespace
name each time.

Running a report on study
archiving status on a Windows
station

1.

At a command prompt, type

mig-study-archive-report.exe -d
mvf_version_number -U
IMPAX_database_user -P
IMPAX_database_password

. To create a report file with this information,

type

mig_reporter.exe -d
mvf_version_number -t
mig-study-archive-report

Running a report on study
archiving status on a Solaris
station

1.

2.

At a terminal window, type
mig-study-archive-report -o

To create a report file with this information,
type

mig-reporter -t
mig-study-archive-report
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Checking the operating system

On each server you plan to upgrade (rather than
replace), check the Windows or Solaris operating
system to ensure that it is healthy. This helps to
prevent issues such as bad disk systems or server
hardware faults from affecting the upgrade.

Checking the integrity of database
data

1. To check for uniqueness of OBJECT_REF in
DOSR_OBJECT_DOCUMENT, in ISQL, type

select count(object_ref) from
dosr_object_document where
object_ref in (select object_ref from
dosr_object_document group by
object_ref having count(object_ref)>1).

2. To check for null values in the
DOSR_HIS_STUDY.STUDY_UID column, type

Select count(*) from dosr_his_study
where study_uid is NULL

3. To check for null values in the
DOSR_STUDY.STUDY_UID column, type

Select count(*) from dosr_study where
study_uid is NULL

4. To check for null values in the
DOSR_OBJECT.SOP_INSTANCE_UID column,

type
Select count(*) from dosr_object where
sop_instance_uid is NULL

5. To check for null values in the
DOSR_OBIJECT.SERIES_REF column, type

Select count(*) from dosr_object where
series_ref is NULL

6. To check for null values in the
MAP_JOB.ORIGINATING_USER_ID column,
type
Select count(*) from map_job where
originating_user_id is NULL

7. To check for null values in the
MAP_EVENT.USER_ID column, type

Select count(*) from map_event where
user_id is NULL

8. To check for null values in the
MAP_EVENT_AUDIT.USER_ID column, type

Select count(*) from map_event_audit
where user_id is NULL

9. To check for null values in the
MITRA_FOLDER.FOLDER_NAME column, type

Select count(*) from mitra_folder
where folder_name is NULL

10. To check for null values in the
MITRA_FOLDER_ITEM.ITEM_NAME column,
type

Select count(*) from mitra_folder_item
where item_name is NULL

11. To check for null values in the
MITRA_PRINT_PARAMS.USER_ID column,

type
Select count(*) from

mitra_print_params where user_id is
NULL

12. To check for null values in the
AGFAHC_REPORT_ACCESS _
CONFIG.AE_TITLE; column, type

Select count(*) from
agfahc_report_access_config where
ae_title is NULL

13. If the return value is > 0 for any of these,
a NULL value exists in that column. If
duplicates or nulls are found, contact Agfa
support for assistance in dealing with them.

Collecting data on the WEB1000
or IMPAX user base

1. Open a command prompt on the Application
Server and navigate to C:\mvf-mig6\bin.

2. At the prompt, type

user_base_summary.exe -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user
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-P
IMPAX_4.5 5.2 or_5.3 database password

3. Type

mig_reporter.exe -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user
-P
IMPAX_4.5_5.2_or_5.3_database_password
-t user_base_summary

Viewing the report on the
WEB1000 or IMPAX user base

1. On the Application Server, navigate to
C:\mvf-mig6\reports.

2. Using a text editor such as Notepad, open
the file
database_server_name_user_base_summary
_REPORT_1_date_and_time .

Getting a list of IMPAX Client
station names

1. On the Application Server, open a command
prompt and change to the
C:\mvf-mig6\bin directory.

2. Type the following:

get_station _mapping.exe -m List -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user
-P

IMPAX 4.5 5.2 or_5.3 database password

3. Type the following:

mig_reporter.exe -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user
-P

IMPAX_4.5 5.2 or_5.3 database password
-t get_station_mapping

Updating the host_list file

1. Open the report created when getting a list
of IMPAX Client station names.

2. From the C:\mvf-mig6\bin folder, open the
host_list file.
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4,

Using the station info mapping tool report,
add each IMPAX Client station host name or
IP address to the host_list file.

Save the host_list file.

Modifying the Windows XP
network access settings

1.
2.
3.

Open the Windows Administrative Tools.
Select Local Security Policy.

In the navigation pane, select Local
Policies > Security Options.

Double-click Network access: Sharing
and security model for local accounts.

If the selected list option is Guest only -
local users authenticate as Guest, change it
to Classic - local users authenticate as
themselves.

6. Click Apply. Click OK.
7. To close the Local Security Settings window,

select File > Exit.

Mapping multiple IMPAX Client
station names to machine
identifiers

1.

If the administrator usernames and
passwords are the same for all IMPAX Client
machines, on the Application Server, open
a command prompt.

. Type

run_psexec.bat
[administrator_username
administrator_password]

Verifying that all IMPAX Client
station names have been mapped

1.

2.

Run the get_station_mapping.exe
command.

Run the following command:

mig_reporter.exe -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user

-P

IMPAX_4.5 5.2 or_5.3 database password
-t get_station_mapping

Verify that no station names are listed in
the report.

If any station names are listed, add them
to the host_list file and run the
run_psexec.bat command again.

Mapping individual Client station
names

Instead of mapping all Client station names at
once, you can perform a set of tasks on each
Client station individually.

Retrieving the IMPAX Client
station name

1.

2.

On the Client station, open a command
prompt.

Change to the location of the
get_station_mapping.exe file.

. Type the following:

get_station _mapping.exe -m List -d
mvf_version_number -U
IMPAX_database_user -P
IMPAX_database_password

. Type the following:

mig_reporter.exe -t
get_station_mapping -d
mvf_version_number -U
IMPAX_database_user -P
IMPAX_database_password

Mapping an IMPAX Client station
name to a machine identifier

1.

On the Client station, open a command
prompt.

Navigate to the location of the
get_station_mapping.exe file.

. At the prompt, type the following:

get_station_mapping.exe -m add -d
mvf_version_number -U
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IMPAX_database_user -P
IMPAX_database_password

Exporting user data

1.

2.

Open a command prompt on the Application
Server.

Change to the
C:\mvf-mig6\UserMigration directory.

. To export IMPAX 4.5, 5.2, or 5.3 user

information, type

migrate-users.exe -m mvf2xml -d
mvf_version_number -U
IMPAX_4.5 5.2 or_5.3 database_user
-P

IMPAX 4.5 5.2 or 5.3 database password

. To export WEB1000 user information after

exporting the IMPAX MVF data, type

migrate-users.exe -m mvf2xml -d mvf
-U MVF_database_user -P
MVF_database_password -ud mvf_web
-uU WEB1000_database user -uP
WEB1000_database_password

or

To export only WEB1000 users information
(no IMPAX data to migrate), type

migrate-users.exe -m mvf2xml -d
mvf_web -U WEB1000_database user
-P WEB1000_database_password

Deleting special characters in user
names

1.
2.

Open the users.xml file in a text editor.

In each UserName and Fullname field, check
for and delete any instances of the following
characters:

=+<>#;/\

3. Save and close the users.xml file.

4. Repeat with the webusers.xml file, if

applicable.
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Planning the migration of user
preferences

To mitigate the potential pitfalls, work with the
site to effectively plan the migration of user
preferences, following steps such as the following:

1. Define the appropriate hierarchy of roles
and users, determining which preferences
should be inherited by all.

2. Define which preferences will be getting
migrated at the user level, therefore
overriding role inheritance, by consulting
the exported user data and the list of .

3. Pinpoint areas where the migrated
preferences would interfere with the
preferred inheritance model.

Depending on how many preference groups would
be affected, and how many users need migrating,
you can then manage the problem one of two
ways:

1. Do not migrate users. Instead, re-create
them all in the training server cluster.

or
2. Migrate the users, then remove the custom
preferences where needed.

Disabling the password and
account lockout policies

1. Open the Windows Administrative Tools and
select Local Security Settings.

2. In the navigation pane, expand Account
Policies and select Password Policy.

3. To modify the Password Policy information,
double-click the policy to be changed.

4. Under Account Policies, click Account
Lockout Policy.

5. To modify the Account Lockout Policy
information, double-click Account lockout
threshold.

6. Set its value to 0 and click OK.

7. To close Local Security Settings, select File
> Exit.

Backing up the ADAM database

1. Select Start > All Programs >
Accessories > System Tools > Backup.

2. Select Tools > Options.
3. Switch to the Exclude Files tab.

4. Inthe list of file names, select C:\Program
Files\Microsoft ADAM and click Remove.
Click OK.

5. When the Backup or Restore Wizard is
displayed, clear the Always start in
Wizard mode checkbox and click
Advanced Mode.

6. On the Welcome screen, click Backup
Wizard.

7. On the Backup Wizard screen, click Next.

8. On the What to Backup screen, select
Backup selected files, drives, or
network data. Click Next.

9. On the Items to Backup screen, select the
folder containing the ADAM data as well as
the World Wide Web Publishing Service
folder. Click Next.

10. If backing up to a tape drive, under Backup
media type, select the tape drive, and in the
backup media area, click New media. Click
Next.

or

If backing up to any other media type, select
the location where the backup is to be
saved, and type a name for the backup.
Click Next.

11. On the Completing the Backup Wizard
screen, click Advanced.

12. On the Type of Backup screen, select
Normal. Click Next.

13. On the How to Backup screen, select Verify
data after backup and Use hardware
compression if available. Click Next.
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14. On the Backup Options screen, select
Replace the existing backups. Click Next.

15. On the When to Backup screen, select Now.
Click Finish.

16. In the Backup Progress dialog, click Close.
17. Close the Backup Utility.

Setting up custom roles
1. Log into the IMPAX 6.5.1 Client.
2. From the Configure area drawer menu u,
select Users and Roles.

3. To add a role within a role, in the navigation
pane, right-click the role and select Add
Role.

or

To add a role at the top level of the role
hierarchy, right-click in the navigation pane
below the defined roles and select Add
Roles.

4. Rename the new role.

5. Repeat for any other roles to create.

Mapping IMPAX or WEB1000
privileges to custom roles

1. In the UserMigration folder where the
Migration Tools are installed, locate and
open the configuration file called
migrate-users.exe.config.

2. Compare the privileges in the database with
the role mapping in the
migrate-users.exe.config file.

3. To map an IMPAX or WEB1000 privilege to
a custom IMPAX 6.5.1 role, add additional
map entries.

4. Save the file.

Converting the user data to LDF
1. Open a command prompt.

2. Change to the
C:\mvf-mig6\UserMigration directory.
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3. To convert only IMPAX 4.5, 5.2. or 5.3 user

information, type

migrate-users.exe -m xml2idf -I
users.xml -d mvf_version_number -U
IMPAX_4.5 5.2 or_5.3 database_user
-P IMPAX_4.5_5.2_or_5.3 database_
password

or

To convert only WEB1000 user information,
type

migrate-users.exe -m xml2idf -I
webusers.xml -d mvf_web -U
MVF_database_user -P
MVF_database_password

or

To export both IMPAX and WEB1000 user
information at once, type

migrate-users.exe -m xml2idf -I
users.xml,webusers.xml -d
mvf_version_number -U
IMPAX_4.5_5.2 or_5.3 database_user
-P

IMPAX_4.5 5.2 or_5.3 database_ password

Migrating user data to ADAM

1.

3.

On the Application Server, open a command
prompt.

Change to the
C:\mvf-mig6\UserMigration directory.

Type

Idifde -i -s
fully _qualified_domain_name_of_ADAM_host
-f LDF_input_file -t 636

If you have a conflict.Idf file that contains
user IDs representing unique individuals,
run the Idifde command again and use that
conflict.ldf file as the LDF_input file.

Backing up the ADAM database
again

1.

As all user data has been migrated to the
ADAM database, back up the ADAM database

again—using a different name than used for
any prior backup.

Updating ADAM passwords

1. On the Application Server, open a command
prompt.

2. Change to the
C:\mvf-mig6\UserMigration directory.

3. Type

migrate-users.exe -m postimport -d
mvf_version_number -U mvf -P mvf

or, for WEB1000-only sites:

migrate-users.exe -m postimport -d
mvf_web -U mvf -P mvf

Updating study comments after
upgrading to IMPAX 5.2 from
IMPAX 4.5

1. Launch CLUI.
2. Type

Update DOSR_STUDY set
study_comments_utf8=study_comments
where study_comments is not null

Running a final report on study
archiving status

1. At a command prompt, for Windows, type

mig-study-archive-report.exe -U
IMPAX_5.2_or_5.3_database_user -P
IMPAX_5.2_or_5.3 database_password
-d mvf_version_number -o

or, for Solaris, type

mig-study-archive-report -U
IMPAX_5.2 or_5.3 database_user -P
IMPAX_5.2_or_5.3 database_password
-d mvf_version_number -o

Importing IMPAX users into the
traveling server

1. Loginto the AS3000 Database Server as the
mvf user.
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Run the following command:
sqlplus dbadmin/dbadmin

select count(*) from user_tab_columns
where table_name=
'MITRA_DISPLAY_MODALITY_CONFIG'
and column_name=
'CONTROLLER_MODE_DEFAULT";

If the output is 0, add a column named
CONTROLLER_MODE_DEFAULT to the
MITRA_DISPLAY_MODALITY_CONFIG table.

Trimming map_event and
map_event_audit tables

1.

On Windows, open the SQL Server Query
Analyzer.

On Solaris, launch CLUI.

2. Type select count(*) from map_event.

3. On Windows, click Execute.

4. Type select count(*) from

5.

map_event_audit.

On Windows, click Execute.

Creating the AS3000 software
repository

1.

On the AS3000 Database Server, create a
directory for the repository by typing mkdir
/agfa/repository

Copy the IMPAX 6.5.1 AS3000 Server ISO
file to this repository.

. As the root user, type:

# lofiadm -a /agfa/repository/IMPAX
6.5 AS3000 Server.iso

/dev/lofi/1

# mount -F hsfs /dev/lofi/1 /mnt
# cd /mnt

# cp -r . /agfa/repository

Unmount /mnt and optionally remove the
IMPAX 6.5.1 AS3000 Server ISO file.
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Copy the Oracle for Solaris ISO file to the
repository.

Repeat the process to extract and copy the
Oracle software to the repository.

To create the AS3000 software repository using DVDs

1.

On the AS3000 Database Server, log in as
the root user and create a directory for the
repository by typing mkdir
/agfa/repository

2. Insert the IMPAX 6.5.1 AS3000 Server DVD.

3. Change to the /cdrom/cdromO directory.

Copy and unpack the files from the DVD by
typing

tar cvf - . | (cd /agfa/repository ; tar
xf =)

Remove the IMPAX AS3000 DVD and insert
the Oracle for Solaris DVD.

Still in the /cdrom/cdromO directory, copy
and unpack the files from this DVD as well.

tar cvf - . | (cd /agfa/repository ; tar
xf =)

Creating an AS3000 build report
repository

1.

On the server, log in as the mvf user and
create the following directory:
/usr/mvf/reporting_tables.

Insert the Connectivity Manager 2.1.1 or 2.2
CD.

Navigate to the
/ cbframework-platform/AgfaHC-database
directory on the CD.

Copy the following files from the
AgfaHC-database directory into the
Jusr/mvf/reporting_tables directory:

a. agfahc-sql.schema.oracle
b. build-oracle-database.bash

c. regrant-oracle.bash

10.

11.

Change to the
/usr/mvf/reporting_tables directory.

. To grant execute permissions on the script

files, run the following command:

chmod 777 build-oracle-database.bash

. To run the command, type

./ build-oracle-database.bash.

Remove the Connectivity Manager CD and
insert the IMPAX 6.5.1 Migration CD.

Log in as user root.

Navigate to the SunOS5 directory on the
CD.

Type
pkgadd -d IMPAXmigration.pkg

Preparing the database for report
migration

1.

2.

On the Connectivity Manager, in Query
Analyzer, run the following queries:

a. use mcf

b. select distinct use_of_patient_id
from mcf_patient_id

c. select distinct
issuer_of_patient_id from
mcf_patient_id

If either of these queries gets more than
one response, this may indicate a problem.
To resolve it, work with the Connectivity
Manager integrator and Agfa support.

Updating the database statistics

1.
2.

3.

4.

Log into the Database Server.
Start an sqlplus session by typing
sqlplus / as sysdba

Type the following command:

exec
dbms_scheduler.run_job('gather_stats_job');

Type the following command:
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exec dbms_scheduler.run_job
('dbadmin.gather_and_lock_stats_job');

. Log into the Database Server as the oracle

(traveling server) or service (IMPAX 5.2 or
5.3 server) user.

On Solaris, type
analyze-tables

If errors occur, check
/usr/mvf/data/logs/analyze-tables.log for
details.

Identifying the report source

1.

2.

On the Connectivity Manager, open osql and
type
use mcf;

select distinct(requesting_service) from
mcf_service_request;

To prepare for upgrading the database, note
the value stored in the requesting_service
field.

If multiple values are returned in the
requesting_service field, consult a
Connectivity Manager integrator, as data
and mappings may need to be updated.

Verifying the version of Oracle

1.

2.

On the AS3000 Database Server, log in as
the mvf user.

Type the following commands:
sqlplus /nolog
SQ.> connect sys/stayout as sysdba

SQ.> select
COMP_ID,COMP_NAME,VERSION,STATUS
from dba_registry;

. If the version displayed is 9.2.0.1, the

Oracle 9.2.0.4 upgrade was not completed
correctly. Upgrade Oracle to version 9.2.0.4
now.
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Backing up the AS300 SQL 2000
database

1. On the server running the AS300 database,
select Start > All Programs > Microsoft
SQL Server > Enterprise Manager.

2. In the Explorer window of the Enterprise
Manager, expand Console Root >
Microsoft SQL Servers > SQL Server
Group > server > Databases > MVF

3. Select Action > All Tasks > Backup
database.

4. In the SQL Server Backup screen, in the
Backup section, select
Database-complete.

5. Click Add and specify the directory to back
up to.

6. To start the backup, click OK.

7. Exit the SQL Server Enterprise Manager.
Backing up the AS3000 Oracle
database

1. If backing up to tape, insert the tape into
the tape drive.

2. Log into the AS3000 Database Server as the
oracle or service user.

3. Type the following command:
/usr/mvf/bin/runbackup.

4. If backing up to tape, when the database is
backed up and the tape is rewound, remove
the tape from the tape drive.

Saving the map_event_audit
tables from an AS3000 Oracle
database

1. Log into the Database Server as the service
user.

2. Launch SQLPIlus and log in as dbadmin.
3. Enter the following command into SQLPIus:

Select CEIL(SUM(bytes)/1024) from
user_segments where

SEGMENT_NAME="MAP_EVENT_AUDIT'
AND SEGMENT_TYPE= 'TABLE';

4. To close SQLPlus, type exit.

5. To save the map_event_audit tables, open
a command prompt and type the following
commands:

exp userid=dbadmin/dbadmin
file=location_you_selected/
MAP_EVENT_AUDIT.dmp
tables=MAP_EVENT_AUDIT

6. Launch SQLPIus and log in as dbadmin.

7. Truncate the table with the following
command:

truncate table map_event_audit;
Saving the map_event_audit

tables from an AS300 SQL Server
database

1. Start the SQL Server Query Analyzer and
log in as the sa user.

2. In Query Analyzer, type
sp_spaceused MAP_EVENT_AUDIT

3. Note the reserved size value returned by
the previous command.

4. Open a command prompt.
5. To save the map_event_audit tables, type

bcp mvf..map_event_audit out
location_you_selected\MAP_EVENT_AUDIT.txt
-Usa-Psa_password -c

6. Close the command prompt.

7. In the Query Analyzer, truncate the
map_event_audit table by typing

truncate table map_event_audit
Checking the integrity and

identity of cache files against the
IMPAX AS300 database

1. In a command prompt, change to the
location of the cache check and repair tools.
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2. Run mvf-check-cache parameters
path_to_cache

Finding files in a cache directory
that are unknown to the database
1. Run mvf-clean-cache parameters
path_to_cache
Moving images from a cache
directory
1. Run the mv_command_file .

Generating a report of lost images

1. Run mvf-report-loss parameters
report_file_name
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